Beginning Spring MVC

Spring MVC is N as its name suggests N an implementation of the model -view -controller design pattern.
The MVC pattern is fundamental to lose coupling between the data, its visual representation and
manipulation. In MVC terms, the data is t he model, the visual representation of the data is the view
and the data manipulator is the controller.

The MVC pattern is not restricted to just the web; you may find the MVC pattern in Java Swing
applications and, outside Java for example in Objective -C Cocoa and Carbon applications.

The clear separation between the M, the V and the C in the pattern means that it is easy to make
changes to each of the components with as little impact on the other components. This is the principle
of loose coupling and, th  erefore, it should not be a great surprise that the MVC pattern gets extensive
support in the Spring Framework. Even though the MVC pattern does not impose any environment,
Spring MVC deals only with web applications.

In this chapter, we will explore how t he Spring Framework implements the MVC design pattern. To
fully understand this chapter, you will need to understand dependency injection, you need to be fluent
in Java annotations and you should be able to understand HTML.

Java EE web application revisite d

We begin by looking at Java EE web applications. Unlike the command -line applications we have been
implementing so far, web applications do not have any public static void main(String[])
method. This method is in the servlet container (Tomcat, for exampl e). The servlet container expects

the web application to follow a predefined structure; it looks for descriptor files and, using the
information in the descriptor files, the servlet container can run the web application.
In practice, the Java EE web applic ationOs structure must follow the one shown in Figure 1.

Figure 1. Java EE web application structure
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Now, the servlet container will read the contents of the web.xml file and construct any servlets it
defines. In our case, the servlet is SpringOs Dispatc herServlet . The DispatcherServlet will



construct the Spring application context by reading a file whose name follows the servletname-
context.xml convention. This Spring application context file defines all controllers, view resolvers,

annotation handlers, validators and many other components we will cover in this chapter. In real
applications, these web components usually need the rest of the application components to operate:

the services, which in turn use the repositories, and so on. These components mus t be ready before
the DispatcherServlet attempts to construct the web components. Spring web applications use
the ContextLoaderListener to construct the bowels of the application, even before the
DispatcherServlet sees the first request. Listing 1 shows th e most important elements of our
web.xml file.
Listing 1. Web.xml file
<?xml version="1.0" encoding="utf - 8"?>
<web- app xmins="http://java.sun.com/xml/ns/javaee"
xmlins:xsi="http://www.w3.0rg/2001/XMLSchema - instance"
xsi:schemalLocation="ht tp:/ljava.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web -app_2_5.xsd"

version="2.5">

<listener>
<listener - class>
org.springframework.web.context.ContextLoaderListener
</listener - class>
</l istener>
<context - param>
<param - name>contextClass</param - name>
<param - value>
com.springsource.server.web.dm.ServerOsgiBundleXmlWebApplicationContext
</param - value>
</context - param>
<servlet>
<servlet - name>mvcl</servlet - name>
<servlet - class>
org.springframework.web.servlet.DispatcherServlet
</servlet - class>
<load - on- startup>1</load - on- startup>
</servlet>
<servlet - mapping>
<servlet - name>mvcl</servlet - name>
<url - pattern>/</url - pattern>
</servlet - mapping>

</web - app>

The two most important elements in Listing 1 are the ContextLoaderListener (with its
context - param set to ServerOsgiBundleXmlWebApplicationContext ) and the
DispatcherServlet .Itis time to explore how the DispatcherServlet handles the requests.
Setting up

Before we start exploring Spring MVC, letOs take a moment to use STS to configure a Spring web
application. We begin by running the STS and setting up the SpringSource dm Server. In the Servers
view, right click and select New > (see Figure 2).

Figure 2. New server definition in STS
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In the New Server wizard, select SpringSource dm Server v2.0 and click Next >. On the next page,
select the directory where you installed the SpringSou rce dm Server and click Next >; on the final
page simply click Finish. Figure 3 shows the sequence of the screens.

Figure 3. Configuring SpringSource dm Server
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Once the server is configured, we can start creating a new Spring MVC application. We w ill create
a new Dynamic Web Project in STS. In the New Dynamic Web Project wizard, make sure that you
configure the Java sources to include src/main/java and src/main/resource S. On the next

page, define the Web Content Root as src/main/webapp  (see Figure 4).

Figure 4. Configuring sources in the New Dynamic Web Project wizard
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To complete the configuration of our project, we will add the Spring Project and OSGi Bundle
project natures. To do so, right click on the project, select Spring Tools and click on Add Spring
Project Nature and Add OSGi Bundle Project Nature (see Figure 5).

Figure 5. Adding the Spring and OSGi natures

"B New >
Co Into
Show In X 8W >
= Copy #8C
¥ B2 Copy Qualified Name
- Paste ®V
¥ Delete ®
Build Path >
Refactor N 8T >
Import >
Export >
& Refresh F5
Close Project
Close Unrelated Projects
Validate
Show in Remote Systems view
m2 Maven >
Run As >
Debug As >
Profile As >
Team >
Compare With >
Restore from Local History...
Spring Tools > Add Roo Project Nature
Java EE Tools > X .
Source > Add Spnng_ Project Nature ‘
Configure > Enable Spring Aspects Tooling
Properties v Add OSG! Plan ProjecF Nature
Add OSGi Bundle Project Nature
This completes the setup of the project. We now have an OSGi -based Spring web application. The
last thing we need to do is to con figure the required bundles in META -INF/MANIFEST.MF. If you need

to refresh your memory about OSGi, go back to the Intoduction to OSGi chapter.
If you already know OSGi or do not want to deal with the OSGi details just now, you can simply
use the code in L isting 2 in MANIFEST.MF.



Listing 2. MANIFEST.MF

Manifest - Version: 1.0

Bundle - SymbolicName: net.cakesolutions.openspring3.mvcl

Bundle - Version: 1.0.0

Bundle - Name: Open Spring 3 MVC 1

Import - Bundle: com.springsource.javax.servlet;version="[2.5.0,2.5.0]",

com .springsource.server.web.dm;version="[2.0.0.RELEASE,2.0.0.RELEASE]",
com.springsource.javax.servlet.jsp.jstl;version="[1.1.2,1.1.2]",
com.springsource.org.apache.taglibs.standard;version="[1.1.2,1.1.2]",
com.springsource.org.apache.commons.lang;version= "[2.4.0,2.4.0]",
com.springsource.javax.servlet.jsp;version="[2.1.0,2.1.0]",

Web ContextPath: /

Import - Library: org.springframework.spring;version="[3.0.2.RELEASE,3.0.2.RELEASE]"

Without delving into the details of OSGi too much, you can see that our web application depends
on the following bundles:

I Java servlet API version 2.5.0

I SpringSource dm Server web components version 2.0.0.RELEASE
I Java JSP API version 1.1.2

I Java JSTL API version 2.1.0

I Apache standard tag library version 1.1.2

I Apache commons lang ve  rsion 2.4.0

! Spring Framework version 3.0.2.RELEASE

The MANIFEST.MFfile tells the SpringSource dm Server which bundles it needs to resolve to start
our application. Now, if we start the application, it wonOt work just yet. We will need to provide the
Sprin g configuration for the components of the web tier as well as configuration for all other
components that make up our application.

The story of the film so far
If we were in Monty Python and the Holy Grail, we could say:
Doug and Bob are metropolitan poli cemen with a difference. Doug likes nothing more than slipping

into little cocktail frocks, while Bob bouffants his hair for a night on duty. Still, as the art immace,
no one gives their last names.

The real story of the film so far:

Pucky Reginald Vas De ferens is a nuclear scientist in love with mafia boss Enrico Marx, who is
himself married to Conchito Macbeth, a lively belly -dancer at the Belgian disco whose managerE

Unfortunately, we are just Java EE programmers. And so, we have to explore what happens in our
servlet container (see Figure 6).

Figure 6. Spring Java EE web application start up
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We see that the servlet container deploys our application (1) and, during this process, it reads the

WEB INF/web.xml fle. The web.xml file defines the ContextLoa derListener and the
DispatcherServlet . The ContextLoaderListener builds the bowels of our Spring -powered
application. It does this by default by loading the beans in the WEB
INF/applicationContext .xml file (you can configure the listener to look for files with any other
name) . Next, the DispatcherServlet will look for file whose name matches the value of the
servlet -name elementin web.xml . In our example, the servlet -name in web.xml is mvcl;
therefore, the  DispatcherServiet will look for  WEBINF/mvcl - servl et.xml . In essence, the
web.xml , applicationContext.xml and name- servlet.xml files make up the entire Spring
configuration of the application. To complete the discussion, we will show the contents of the

configuration files.

Listing 3. Contents of the web.xml file

<?xml version="1.0" encoding="utf - 8"?>
<web- app xmins="http://java.sun.com/xml/ns/javaee"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema - instance"
xsi: schemalocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web -app_2_5.xsd"
version="2.5">
<listener>
<listener - class>
org.springframework.web.context.ContextLoaderListener
</listener - class>
</listener>

<context - param>
<param - name>contextClass</param - hame>
<param - value>
com.springsource.server.web.dm. !
ServerOsgiBundleXmIWebApplicationContext
</param - value>
</context - param>

<servlet>
<servlet -name>mvcl</servlet -name>
<servlet -class>

org.springframework.web .servlet.DispatcherServlet
</servlet - class>
<load - on- startup>1</load - on- startup>

</servlet>

<servlet - mapping>
<servlet -name>mvcl</servlet -name>



<url - pattern>/</url - pattern>
</servlet - mapping>

</web - app>

The web.xml defines the listener ( of type ContextLoaderListener ) and specifies the listener
parameters ; it also defines the serviet name and type ( mvcl and Disp atcherServiet ,
respectively ). Finally, we map all requests to the mvcl servlet.

Next, we need to examine the configuration of the servlet tier, in  mvcl- servlet.xml (Listing 4 ).

Listing 4. Contents of mvcl -servlet.xml

<?xml version="1.0" encoding="UTF -8"?>

<beans xmins="http://www.springframework.org/schema/beans"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema - instance"
xmins:context="http: Imww.springframework.org/schema/context”
xmlIns:mvc="http://www.springframework.org/schema/mvc"
xsi:schemalocation="http://www.springframework.org/schema/mvc

http://www.springframework.org/schema/mvc/spring - mvc- 3.0.xsd
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring - beans.xsd
http://www.springframework.org/schema/context
http://www.springframework.org/schema/context/spring - context.xsd">
<context:component - scan base - package="net.cakesolutions.openspring3.mvcl" />
<mvc:annotation - driven/>
</ beans >
That was easy! All we need to do is to component -scan for our web components (in package
net.cakesolutions.openspring3.mvcl ) and accept the default Spring MVC configuration in the
<mvc:annotation  -driven/>  element.
We complete the  configuration of the application in applicationContext.xml . Because we will
be focusing on the servlet tier only, the applicationContext.xml will remain empty. Listing 5

shows the contents of this configuration file.

Listing 5. Empty applicationContext.xml

<?xml version="1.0" encoding="UTF -8"?>
<beans xmins="http://www.springframework.org/schema/beans"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema - instance"
xsi:schemalocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/ beans/spring - beans.xsd">
</ beans >

Now that we have all three XML and the MANIFEST.MF files in place, we can start the application.
We will drag and drop the project onto the Spring Source dm Server node in the Servers tab. Once
fully configured, STS should show the application under the server node in the Servers tab. If your
STS looks like the screenshot in Figure 7, you @e ready to go.

Figure 7. The dm Server node in the Servers tab with the application ready to run
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Without further delay, select the server node and press the debug button.

Allons -y!
TBC

So much for Spring -powered applications . However, even in traditional (read old -school) servlet
applications, there are usually multiple servlets, each servlet implemented in its own class and each
servlet handling requests to a specific URL. In Spring web applications, there is usually just th
DispatcherServlet , which handles all requests.

From high above, the DispatcherServlet needs to route the requests to the appropriate
controllers; the controllers react to the requests, prepare models and indicate which view should
render the model. The dispatcher servlet takes the model and the view and finds the required view

that will ultimately render the model. The DispatcherServlet will return whatever the viewOs
rendering method returns. In this sense, the DispatcherServlet is the controller, the ¢~ omponents
we call controllers in Spring are more like controller workers. In Spring -speak, they are sometimes

called handlers.
Read on to find out how the DispatcherServlet does this.

The DispatcherServlet

As you have already seen, the DispatcherServlet is the central point of a Spring Framework web
application. The servlet handles all requests (passed on to it by the servlet container). To handle the

request, it must find one of our controllers, look up the appropriate handler method; then it must

examine the handler methodOs signature and prepare the argument values. It must then invoke the
method and examine the returned value. Depending on the returned value, the
DispatcherServlet may have to find the appropriate view. Finally, it will take the model th
handler method prepared (the model may remain empty if the handler method does not add any
attributes to the model); it will give the prepared model to the view and pass on whatever the view

returned back to the servlet container as the response to the r equest. The servlet container will in
turn pass on this response to the client. Figure 3 shows what is happening.

Figure 3. DispatcherServlet processing requests
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What can the DispatcherServlet use to route the request N and here by request we mean the
Http ServletRequest 2 It can use its URL, HTTP method, query parameters, header parameters,
and the values of the cookies. In fact, the DispatcherServlet can use any combination of these



attributes of the  HttpServletRequest to find the appropriate handler (and a ppropriate method in
the handler) that maps to the request. Once the handler method completes, the

DispatcherServlet will examine the returned value and locate the appropriate view and pass the
model the handler method prepared to the viewOs rendering meth od.

However, it would be bad design to include all code to handle all the request routing logic in the
DispatcherServlet itself. Furthermore, there is infinite number ' of combinations for the
arguments of the handler methods. Additionally, the handler met hods should be able to signal how
the rest of the framework should continue processing the request. The DispatcherServlet

therefore needs these components:

I HandlerMapping
Finds handler chain that could handle the request (typically the OcontrollerO beans); it maps the
requests to a chain of handlers that could contain handler methods that may ultimately handle
the request.

I HandlerAdapter
Presents a unified interface to allow the DispatcherServlet to invoke the handler method;
it adapts the varying handler m  ethod signatures, thus allowing the DispatcherServlet to
execute any handler method.

I ViewResolver

Allows the DispatcherServlet to locale an appropriate  View interface implementation if the
handler method does not return the ModelAndView object with its ~ vie wproperty isnot null ;
if all that the  DispatcherServiet has is a view name (we will explore how it may obtain it

later on), it will use the ViewResolver to resolve the name into a View).

Request routing

LetOs now examine in detail how the DispatcherServ  let uses the HandlerMapping s,
HandlerAdapter s and ViewResolver s to process the request. We begin by looking at how the

Spring Framework locates the handler and the handler method to process the request. We will use the
contemporary  implementations:  the Def aultAnnotationHandlerMapping and  the
AnnotationMethodHandlerAdapter . As the handler adapterOs and handler mappingOs class names
suggest, they look at the annotations in the handler beans N we will explore the details later on in this
chapter N for now, letDs a ssume that all handlers carry the @Controller  stereotype annotation.

Suppose now that the servlet container receives some request; also suppose that the
DispatcherServlet defined in the web.xml file is mapped to the request URL (see <servlet -
mapping> in Listing 1). The servlet container will invoke the DispatcherServlet Os service
method; the implementation of the DispatcherServlet will ultimately invoke the doDispatch
method. The doDispatch  method will then delegate to the configured HandlerMapping  and
HandlerAdapter  to find the handler that will ultimately process the request. The HandlerMapping
will construct the  HandlerExecutionChain . The DispatcherSerlvet will then iterate over each
entry in the HandlerExecutionChain and check that the configured Handle rAdapter can
perform the required action given the handler and the request. If so, then the DispatcherServlet
will call the HandlerAdapter Oshandle method. The handle method returns ModelAndView , which,
as its name suggests, contains the model and the view

Unfortunately, the ~ ModelAndView class name is misleading: it always contains the model; in
some cases, it carries only the view name while in other cases it carries the complete View
instance.

Once the HandlerAdapter Oshanle method completes, the Dispat cherServlet will examine
the returned  ModelAndView , then:

I if view isnot null ,the DispatcherServlet will invoke view.render(model) ;
I if view is null , but viewName is not null , the DispatcherServiet iterate over all
! Really, there are infinitely many combinations of t he handler methods® arguments. For every n

possible combinations you give me, | can always give you n + 1 combination. !



configured ViewResolver s and, for each Vi ewResolver , it will call the resolveView
method to attempt to turn the String viewName  intoa View.The DispatcherServlet will
use the firstnon -null  View;

I finally, if both view and viewName are null ,the DispatcherServiet will attempt to find
the view nam e using the configured RequestToViewNameTranslator . If the view and
viewName remain null  even after the translation, the DispatcherServlet will not

perform any further processing (in this case, the handler method has typically written some
output directly  to the response)

This is the essence of request dispatching in Spring MVC. As you can see, it is not conceptually
difficult; the DispatcherServlet carefully delegates the work to the HandlerAdapter s,
HandlerMapping sand ViewResolver s.

Routing example

LetOssee how the routing strategy we discussed works in practice. We will use the code in Listing 2 to
explain how the handler mapping and handler adapters work.

Listing 2. Simple controller

@cController
public  class IndexController {

@RequestMapping (value = "/a" )
public void a() {

@RequestMapping (value = "Ib" )
public  String b() {
return  "Xx"

@RequestMapping (value = "Ic"
public  ModelAndView c() {

}

Suppose now that the servlet container receives a HTTP requ est for /a URL (and that this URL is
mapped to our DispatcherServlet and that we are using the
DefaultAnnotationHandlerMapping and the AnnotationMethodHandlerAdapter ): the
HandlerMapping  will return the  HandlerExecutionChanin that contains only one handler , the
IndexController . The DispatcherServlet will call the handler adapterOs ~ handle method on the
first and only entry in the HandlerExecutionChain . Now, the
AnnotationMethodHandlerAdapter will discover that there is a method in the
IndexController that ca n handle the /a URL (by examining the =~ @RequestMapping annotation).
It will then invoke the IndexController.a method. Because the method returns void , the model
will remain empty (pay attention, empty not null 1); and the view and the viewName will also
remain null . Because the view and the viewName are null , there is no more work for the
DispatcherServlet and the request processing completes.

Now, in another example, letOs issue a request for the /b URL. The handler mapping will return the
same HandlerExecut ionChain ; the handler adapter will now find the b method in the
IndexController . Because the b method returns  String , the Spring Framework will use the
returned String asthe viewName. Therefore, in this example, the model will still remain empty, but
the viewName is set. The DispatcherServiet will therefore iterate over all ViewResolver s and,
for every ViewResolver it will call its resolveView  method. If that method returns a non -null
View, the DispatcherServlet will take that view and call its render met hod, thus completing the
request processing.

Finally, in the last example, the request is for the /c  URL. The handler method returns
ModelAndView , making the HandlerAdapter Os job easier: the adapter will take whatever model
and view (or viewName) the handl er method returns. The DispatcherServlet will continue
processing just like in the previous two examples. Typically, in this situation, the returned
ModelAndView will include some custom View instance.



The handlers

As we said in the previous section, we a re going to consider the contemporary implementations of the
HandlerMapping and HandlerAdapter interfaces: the  DefaultAnnotationHandlerMapping
and the AnnotationMethodHandlerAdapter . These implementations of the HandlerMapping
and HandlerAdapter use the an notations on the handlers (the @Controller stereotype classes)
and annotations on their methods.

We will begin with an overview of our goal: we would like to implement handler methods that
handle requests in Table 1.

Table 1. URLs and handler methods

URL Handler method
GET /home void home()
GET /posts?start=5&count=20 void posts(int start, int count)
GET /post/my-post-name/edit String edit(String title)
POST post form to /post/add String add(Post post)
Fear not, we will tackle requests that are more c omplicated later. For now, letDs construct the

appropriate annotations and handler methods for our four example URLs. Typically, weOd create the
OhomeO controller and OpostsO controller, but in this example, we will use just one controller. Listing 3
shows its code.

Listing 3. Example controller code

@cController
public class ExampleController {
@RequestMapping (value = "Ilhome" , method = RequestMethod.GET)
public  void home() {}
@RequestMapping (value = "Iposts" , method = RequestMethod.GET)
public  void posts( @RequestParam int start, @RequestParam int count) {}
@RequestMapping (value = "/post/{title}/edit" , method = RequestMethod.GET)

public  String edit( @PathVariable  String title) {
return  "viewName" ;

}
@RequestMappi ng(value = "/post/add" , method = RequestMethod.POST)
public  String add( @ModelAttribute Post post) {
return  "redirect:/posts.html" ;
}

}

This fully implements the handler (and the handler methods) that handle the four URLs from Table
1. LetOs examine the methods and their annotations in detail, starting with

@RequestMapping (value = "Ilhome" , method = RequestMethod.GET)
public  void home() {}
When the DispatcherServlet receives a request to the /home URL, it 2 will find this handler and

the home handler method. It will use reflection to find the methodOs arguments (none) and its return

type ( void ). This means that the HandlerAdapter  has very little work to do N thereOs no need to
prepare arguments or examine the return type. It will simply create em pty ModelAndView object,
invoke the handler method and return to the DispatcherServiet . The DispatcherServlet will
see that the view and viewName in the ModelAndView are null , and will attempt to translate the
request URI to view name. The DefaultRequestTo  ViewNameTranslator will examine the
request URI (/home) and return "/home" as view name. The DispatcherServlet will continue the
request processing, invoking, in sequence, each configured ViewResolver OsresolveViewName
method until the method returns non -null  View or until there are no more ViewResolver s. If the
DispatcherServlet obtains a View, itwill callits render method, passing in the model.

? Not the DispatcherServlet itself, naturally; but the HandlerMapping
and HandlerAdapter




Onwards! The next URL is /posts?start=5&count=20; its handler method is
@RequestMapping (value = "Iposts" , meth od = RequestMethod.GET)
public  void posts( @RequestParam int start, @RequestParam int count) {}

When the servlet receives a GET request to the /posts URL, it will find the posts handler method in
the ExampleController . The handler method adapter now has a bit more work to do. The handler
method needs two arguments of type int and the arguments carry the @RequestParam annotation.
The adapter understands that it will need to get the parameter values from the request. By default,
the adapter will use the argum ent name as request parameter name. In essence, the adapter is

executing this code:
int pl= convert(request.getParameter( "start" ));
int p2=  convert(request.getParameter( "count" ));
ModelAndView mav = new ModelAndView();
handler.posts(p1, p2);
return  mav;

The rest of the processing sequence remains exactly the same: the DispatcherServlet will
attempt to translate the request to view name and then find the View using the configured
ViewResolver s; if it succeeds, it will use the viewOs render method to produc e the response.

What would happen if we didnOt use the @RequestParam annotations in the handler method? The
adapter would fail, because it would be unable to calculate the value of the parameter to pass to

the handler method. After all, there are 2 2.1 pos sible values of int. Without giving the adapter
information about the purpose of the parameter, it cannot proceed.

The next example uses path variables. As the name suggests, the handler method adapter

computes the value of a path variable using an element of a path (in our case, the request URL). So,
when the servlet receives a GET request to /post/my -special -post/edit, it will find the void
edit(String) method in the  ExampleController . The handler method adapter will process its
parameters, and see the ~ @RthVariable annotation. It will then assign the pattern represented by

{title} in the @RequestMapping to the value of the parameter. The rest of the request

processing remains, unsurprisingly, the same.



